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1 FFT integration 

 

The ibaPda FFT View was integrated into ibaAnalyzer to facilitate offline frequency analysis.  

 

1.1 General 

For each sensor signal that needs to be analyzed, one can create a dockable “FFT view window” via the 

toolbar or the View menu: 

 

 

 

After creation, the FFT view will have a title bar labeled “FFTView” followed by an index. This name can 

be changed by right-clicking the title bar and selecting “rename” from the context menu: 
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To analyze a signal, one can either 

 Drag an analog signal from the signal tree in the FFT view 

 Drag an analog signal from an ibaAnalyzer graph into the FFT view 

After that, one will see the waterfall of the signal. In the example below, you see a waterfall plot, with 

500 planes. Each plane corresponds to one FFT. One can change the selected plane by scrolling. 

 

 

 

To make a deeper analysis of one plane, one can enable slave windows: 

 Spectrum slave graph: displays the spectrum of the plane selected in the waterfall 
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 Time slave graph: displays the time signal based on which the FFT was calculated 
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The waterfall of the FFT view will not always display the complete .dat file. At the left of the toolbar in 

the screenshot, there are two important buttons: 

 

 

 

If the first button is checked, the FFT view will only analyze the data that is in the ibaAnalyzer zoom 

area. You can easily change the zoom area via the ibaAnalyzer navigator window. The FFT view does not 

use zero padding. The remaining data is not used, nor displayed. 

If the second button is checked, the number of planes in the FFT view is adapted automatically, 

matching the size of the dat file. In case the number of samples for one FFT is very high (e.g. >1000000), 

the number of planes is limited automatically, thereby limiting the memory use. In case of 1048576 

samples per plane, the number of planes is limited to 25. 
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1.2 Calculation settings 

 

The calculation settings can be changed via the context menu of the FFT view. 

 

 

 

If you click on the “Spectrum 1” node in the tree on the left, you can change the mathematical details of 

the FFT. The most important setting is the number of Frequency results. If the option “Mechanical 

notation” in the base axes node is off, then the number of frequency results is half the number of 

samples used for one FFT. You can also specify an overlap percentage. 
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The data sources can be chosen or changed from an ibaAnalyzer signal tree in the dropdown box. 

 

 

 

  



Product New Features  

 

 

 
 9/45 

 

 

More settings can be set in the Calculation TAB: 

 

 

 

There is support for power/amplitude, normalization, scaling, averaging, windowing, 

integration/differentiation and units. 
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1.3 Slice slave 

Next to the spectrum and the time slave, the FFT view contains two additional types of slaves. The slice 

slave is one of them. One can use it to study the spectrum value at a moving frequency. First, you have 

to define a marker in the waterfall and attach this marker to a signal: 

 

 

 

Then you can add a slice slave window. If you click to add the window, the property window will appear 

automatically. 
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You choose the marker and the harmonic for the slice slave: 

 

 

 

We have chosen to link the slice slave to the second harmonic of the marker named “new name”. 
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1.4 Marker-spectrum slave 

A marker-spectrum slave can plot “the height of the spectrum at a dynamic frequency”, against this 

dynamic frequency. One can link this marker-spectrum slave graph to any marker present in the 

waterfall. In the screenshot below, the bottom marker-spectrum slave is linked to the green marker. 
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One can hoover the selected dot in the marker-spectrum slave, to see a tooltip providing the number of 

the plane (here it is 32). 
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1.5 Order calculations (Order spectrum analysis) 

 

The FFT view supports FFT calculations in order. An order spectrum is like a normal FFT spectrum, but it 

is normalized against one specific parameter of the process, e.g. the speed at which an object is moving 

through a production line or the rotational speed of a motor. 

Two modes are available: speed and length mode. Here, we shortly discuss an example in speed mode. 
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The mathematical details of the order calculation can be set in the following dialog: 
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The most important settings are: 

 The number of frequency results 

o In this example, this number is half the number of samples for one FFT. 

o In case the option “mechanical notation” is on, this number is the number of 

samples for one FFT divided by 2.56. 

 The speed/length source. This signal can be selected from the ibaAnalyzer signal tree. 

 The speed/length unit 

 The resolution (simplified explanation): 

o Each time that the integral of the speed signal has increased with this amount, 

the vibration signal is sampled once. 

o In case the mode is not speed but length, the same applies, but without integral. 

Determining the ideal settings for an order calculation is work for an expert. Therefore, in this 

document, we only discuss a simple example. Suppose you have  

 a vibration signal  

 a speed signal in Hz, i.e. number of revolutions per second 

The speed unit should be set to Hz: 
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In case the speed unit is changed to Hz (or RPM), another text box appears which allows specifying the 

number samples per revolution. The resolution setting is updated automatically (the resolution is the 

inverse of the number samples per revolution).  

At the bottom, the number of revolutions per FFT is displayed. This latter number depends on the 

number of frequency results and the number of samples per revolution:  

 (65336 * 2) / 16 = 8192 revolutions per FFT 
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Below, you see the result of this order calculation: 
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On the top right, you see the graph of “RisingSine”, the vibration signal. On the bottom right, you see 

the graph of “increasingFreq”, the frequency of the sine wave. 

 

In the FFT view, you see that the order calculation has cancelled out each change in speed. Because of 

the technique of order calculation, the spectrum still has a very high resolution; the delta frequency is 

about 0.0001220, as you can see at the bottom of the property window. 

 

This example was just a simplified case. Our software supports a wide range of settings to perform 

online and offline frequency analysis. Note that order calculations are a very complex matter; please 

contact iba support for more information. 
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1.6 Report generation and printing 

 

1.6.1 Printing 

The default ibaAnalyzer print functionality (Menu → File → Print…) and print preview (Menu → 

File → Print Preview ), will also depict the FFT views after the signal grid and after the 

ibaCapture views (if any). 

 

The views are however not customizable in the default print, for this we recommend using the more 
extensive report generator. 
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1.6.2 Report generation 

Similar as for ibaAnalyzer graphs and ibaCapture views, the FFT views can be dragged into the designer 
in order to include them in a report.  

 

 

 

The objects are located in the variables tree under  

 

Variables → ibaAnalyzer → views 

 

A sub tree for each FFT view is present; the tree has the following objects: 

 Complete: this object depicts the entire FFT view including the main window and the 

slaves, if one does not allocate enough room on the page for this object, this is indicated 

by depicting a scroll-bar. 

 Main_window: this object depicts only the main window of the FFT view. 

 This is followed by an object for each slave window… 

After having dragged an object onto the page in the designer, one can customize it by double clicking on 

it or by going to (Contents) and clicking the customize button in the properties. 
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The options currently available are 

 Show view title: One can uncheck this option if the object should be depicted without a 

title (useful for objects representing slave windows). 

 Print range start: Start of the time range used to calculate the FFTs depicted in the 

report. 

One can check this option and specify an ibaAnalyzer expression if one desires an 

alternative time range start. If this option is not checked, the start of the time range 

equals that of the FFT view in the main ibaAnalyzer window which is, depending on the 

mode of the FFT view, the start of the zoomed area or the start of the entire ibaAnalyzer 

time range. 

 Print range stop: End of the time range used to calculate the FFTs depicted in the report. 

One can check this option and specify an ibaAnalyzer expression if one desires an 

alternative time range end. If this option is not checked the end of the time range equals 

that of the FFT view in the main ibaAnalyzer window which is, depending on the mode of 

the FFT view, the end of the zoomed in area or the end of the entire ibaAnalyzer time 

range. 

 

 

1.7 Miscellaneous features 

 

Next to features already discussed, the FFT view in ibaAnalyzer provides: 

 Customizable additional legends 

 Full support of markers: dynamic and static, harmonics, sidebands, different visualization 

settings… 

 Full support for labels: dynamic and static labels 

 Support for color zones 

o Value zones: other colors depending on the height of the spectrum 

o Delta zones: other colors depending on the frequency range 

 Many zoom and scaling settings 

 … 
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2 New functions 

2.1 SetYatX function 

The SetYatX function allows one to generate a copy of an existing expression with one sample 

altered or inserted. 

The function takes the following arguments: 

 Expression: Signal to alter. 

 Value: The new value of the sample that will be inserted or will alter an existing sample. This 

parameter is expected to be a constant; if the provided expression is not constant, its values will 

be averaged before being used in the function. 

 X: The location to insert a sample into. This parameter is expected to be a constant; if the 

provided expression is not constant, its values will be averaged before being used in the 

function. 

The function will behave differently depending on whether the Expression input parameter is 

equidistantly sampled or not. If equidistantly then: 

 If the X parameter is smaller than the offset of Expression, Expression will be returned unaltered. 

 If the X parameter is exactly equal to the location of the last sample of Expression plus one 

sample interval, Expression will be returned with the additional sample added to the end. This is 

useful to extend an existing signal by one sample. Note that to determine the last sample of 

Expression plus one sample interval, the XSize function can be used. 

 In all other cases, the sample at the exact X location or if no such sample exist, the sample 

immediately to the left of X in Expression, is altered to take on the new Value. 

If Expression is not equidistantly sampled, the function will replace a sample if X is incident with the 

location of an existing sample in Expression, otherwise it will insert a new sample. 
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Note that the function can also be used to insert a new text in a text sample: 

 

 

2.2 AbsoluteTime function 

This function allows one to convert ibaAnalyzer relative times (e.g. retrieved by XFirst, XLast or 

XValues functions) to absolute time. The absolute time is returned as a vector of components, 

the desired specific time component can then be selected with the GetRows function. 

The function takes the following arguments: 

 Time: The relative time to convert. This can be a constant (e.g. retrieved by the XFirst or XLast 

functions) or a varying signal (e.g. retrieved by the XValues function). In the former case, a 

vector with constants is returned. In the latter case, a vector with varying signals is returned. If 

Time is non-equidistantly sampled, the result is non-equidistantly sampled as well with a sample 

reported corresponding with every sample in Time. 

 DoSync: If FALSE, Time is taken to be relative to the time-axis start time. If TRUE, the time is 

taken relative to the start time of the first file the Time expression is dependent on. This 

parameter has no effect if the “Synchronize on recording time” mode for the Time-axis is not 

active as both start times are identical in this case. The time expression can depend on signals 

from different files; if the first such file is a chain of appended files, the start times of all the files 

in the chain are taken into account. This parameter is optional and can be omitted, in which case 

it is FALSE by default. 
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The function returns a vector of time components, the components are: 

 Row 0: The milliseconds component. 

 Row 1: The seconds component. 

 Row 2: The minutes component. 

 Row 3: The hours component. 

 Row 4: The day of the month. 

 Row 5: The month component. 

 Row 6: The year component. 

 Row 7: The day of the year. 

 Row 8: The day of the week, Monday being 1 and Sunday being 7. 
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2.3 FromText function 

The function FromText converts a text channel to a numeric channel. The function takes the 

following arguments: 

 Text: The text channel to convert. 

 Begin: Start index in the string to start interpreting the string as a number. It should be zero-

indexed, i.e. specify 0 to indicate the start of the string. If this parameter is omitted, 0 will be 

used as default value. 

 End: The index of the last character to be used to interpret the string as a number. Further 

characters will be ignored. If this parameter is omitted, the entire remainder of the string will be 

used. 
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2.4 PulseFreq function 

Given a pulse or pulse counter signal, this function estimates the frequency of the pulses in Hz. 

The function takes the following arguments 

 Expression: The pulse or pulse counter. 

 Omega: If different from zero, a filter is applied to the result; this is identical as if the Lp function 

would have been applied with the same Omega value. This parameter is optional; if omitted, no 

filter is applied. 

 EdgeType: One can specify if the signal is a pulse counter or a pulse. In case of a pulse, this 

parameter also indicates if the rising edge, the lower edge or both should be used to estimate 

the frequency. This parameter can take on the following values: 

o -1: Assume a pulse and use the falling edges to estimate the frequency. 

o 0 : Assume a pulse and use both the falling and rising edge to estimate the frequency.  

o 1 : Assume a pulse and use the rising edges to estimate the frequency. 

o 2 : Assume a pulse counter. 

This parameter is optional; if omitted, a pulse counter is assumed.  
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2.5 Interpolation functions for vectors 

 

Note, these functions were implemented in 6.4.1, but they haven’t been documented in a new 

features document until now. 

 

2.5.1 VectorLSQPolyCoef 

To recapitulate, the ibaAnalyzer LSQPolyCoef function calculates for a given channel X and Y 

and a degree, the coefficients of the polynomial determined by the method of least squares so 

that the polynomial maps X onto Y as close as possible. The function returns a vector of 

constants where the first row is the constant of the polynomial; the second row is the coefficient 

of the linear term of the polynomial, the third row is the coefficient of the quadratic term and so 

on. 

VectorLSQPolyCoef makes a least squares approximation as well, but this time, the input is a 

vector of signals and the least squares method is applied for every sample in time, while the X 

and Y sets are gotten in the cross-profile direction. The function takes the following arguments: 

 Vector: The vector to compute the coefficients for. For each sample in time, the Y set will be 

taken from the values of the vector. The X set will be simply the indices of the rows in the vector 

(e.g.: 0, 1, 2, 3,…) unless the input vector was produced in the logicals dialog with a Zone offset 

or Zone widths specified or the SetZoneWidths function was used to produce the input vector. 

 Degree: The degree of the polynomial to calculate, the number of coefficients returned in the 

result vector for each sample in time will be one larger than this. 

The function returns a vector with the coefficients of the polynomial. Contrary to the LSQPolyCoef 

function, the coefficients in the vector will vary over time if the input vector varies. 

 

2.5.2 VectorPolynomial 

Given the coefficient vector returned from VectorLSQPolyCoef, the VectorPolynomial function 

can be used to construct a visual polynomial approximation of the profile used in 

VectorLSQPolyCoef. The function takes the following arguments: 

 Coefs: The coefficient vector generated by VectorLSQPolyCoef. 

 Vector: A vector that will be used to determine where to evaluate the polynomials given by 

Coefs. Again, the X-set will be simply the indices of the rows in the vector (e.g.: 0, 1, 2, 3,…), 

unless the input vector was produced in the logicals dialog with a Zone offset or Zone widths 

specified or the SetZoneWidths function was used to produce the input vector. The actual values 

of the signal in the vector will be ignored. Easiest is to simply provide the input vector used in 

the VectorLSQPolyCoef function, but if one wishes to interpolate or extrapolate, an alternative 

vector can be specified (see the following screenshot for an alternative) 
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2.6 Ranges in signal ID’s 

Note, this functionality was implemented in 6.4.2, but it hasn’t been documented in a new 

features document until now. 

In an ibaAnalyzer expression, when specifying a channel by numeric ID, you can replace any 

part of the ID by a range. IbaAnalyzer will automatically create a vector in such case. This 

eliminates the need to go to the “Logical signals” dialogs in many cases. You can specify an 

asterisk (‘*’) to indicate all available channels or a range by specifying two zero-based indices 

separated by a dash (‘-‘). Some examples: 

 [0:*] : All analog signals from the first module. 

 [0.1-3] : The second, third and fourth digital signal of the first module. 

 [*:1] : For each module, the second analog signal. 

 [*_2:0-2] : For each file opened, the first three analog signals of the third module. 

 [1_*:0:0] : From the second opened file (QDR), for each measuring location, the first analog 

signal of the first module. 

Note that you can combine vectors created in this manner with the MakeVector function, e.g.: 

 MakeVector([0:0-3],[0:5]) 

creates a vector of 5 signals consisting of the first four analog signals of the first module and the sixth 

signal. 
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3 TDMS files 

If ibaAnalyzer has the E-dat license activated, one can import files in the National Instruments TDMS 

data format (files with extension .tdm or .tdms). 

The channel groups of such a file are shown as modules, the respective channels of a channel group are 

located under the respective module. File properties are presented as infofields and channel properties 

as channel infofields. Currently, the channel group properties are not reported as there is no analogous 

concept in ibaAnalyzer.  

Determining the timestamps of the channel samples currently happens on the file start time 

property (datetime) and the wf_increment, wf_start_offset and wf_start_time channel properties. 

Furthermore, the following channel properties will be used: 

 name: Name given to the channel. 

 unit_string: If present, unit given to the channel data. 

 description: If present, used as first comment of the channel. 

 wf_xname: If present, the value of this channel will be used to represent the channel in an 

alternative physical domain. The following values are accepted: 

o length: Length based signals, in the ibaAnalyzer selected default length unit. 

o frequency: Frequency based in Hertz. 

o invlength: Inverse length in 1 over the ibaAnalyzer selected default length unit. 

If the parameter is not present or its value is not supported, the channel is presented as time 
based data in seconds. 

 

To our knowledge, there is no unique way in the TDMS data file format for a channel to indicate 

that the data stored in a channel should be interpreted as a digital signal. However, ibaAnalyzer 

will interpret the channel as digital if one of the following criteria is met: 

 The channel property “ iba_digital ” is present, is of type unsigned 8-bit integer and has 

a value different from zero. 

 The channel property “ unit_string ” is present and has the value “ bit ”. 

 The name of the channel ends with “ [bit] ”. 
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4 Signal tree and search dialog 

 

4.1 Infofields subtrees. 

If an infofield has one or more dots (“.”) in its name, these dots will be used as separators to 

split up the infofield name in parts. The infofield will be shown without the dots in a tree structure 

with the nodes corresponding to the parts. If one or more infofield names have the same prefix 

up to the last dot, they will be shown as sibling nodes. The InfoField and InfoFieldText functions 

still require one to specify all dots (the leaf nodes can still be double-clicked for this purpose). 

 

 

 

This enhancement is purely aesthetical and does not affect any other ibaAnalyzer functionality. 
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4.2 Tooltip for long infofields in signal tree. 

For performance reasons, the total length of the infofield name and the concatenated value 

cannot exceed 80 characters before it is cut off when shown in the signal tree. However, in the 

current version of ibaAnalyzer, a tooltip is shown. It shows the entire infofield if one hovers over 

it. 

 

 

4.3 Additional module column in search dialog 

It is possible to add a column in the search dialog that depicts the name of the module to which 

the signals belong. Also, the signal name and unit can now be hidden (previously only 

comments could be hidden or shown). To show or hide columns, one can right-click on the grid 

and check or uncheck the entries in the context menu. 

 



 New Features Product 

 

36/45  
 

 

 

 

  



Product New Features  

 

 

 
 37/45 

 

 

5 Export 

 

5.1 Persistent sizes for exported graphs 

When exporting graphs as an image to a file or the clipboard, the specified width and height are 

now persistent rather than taken from the graph. A button is present to reset the width and 

height to the dimensions of the selected graph. 

 

 

 

 

 

5.2 Export numerical format 

The options in the extract dialog to specify the number formatting for extracting to ASCII file are 

now also present in the file export dialog. 
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6 View 

 

6.1 Reset dockable window layout 

The layout of dockable windows (signal tree, signal grid, marker grids, etc…) can be reset to the 

default locations that ibaAnalyzer uses when it is installed for the first time. 

Menu → View → Reset window Layout 
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7 Miscellaneous features 

 

7.1  Treatment of signal offsets for length based signals 

Length based signals generated by ibaPDA currently cannot have an x-offset different from 0. 

However, when extracted through ibaAnalyzer and derived from a computation, an x-offset can 

be introduced. When selecting such a signal from a chain of appended .dat files, the offsets 

introduce a gap; i.e. the offset is interpreted relatively to the end of the signal of the previous 

file. 

In the current version of ibaAnalyzer, you can select that the offset should be interpreted as 

absolute; i.e. the signal of any file in the chain shall start at exactly the specified offset 

regardless of any other files in the chain. If the offset is smaller than the length of the signal in 

the previous file (including any offset of that signal), it might however be partially or entirely 

overlapped by that signal. To activate this option: 

Graph Setup or Preferences → X-Axis → Select “Length” tab → Signal from appended files → 

Select the “Use absolute lengths” radio button. 

To deactivate the option, select “Start at end of previous signal”, this option is the default. 

 

 

E.g.: two files “Added” rather than appended (the option has no influence), the signal in the 

second file has an offset of 10 m: 
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The same two files appended with the default option “Start at end of previous signal”; the offset of the 
second signal introduces a gap of 10 m: 

 

 

 

 

The same two files appended with the new option “Use absolute lengths”; the gap has disappeared as 
the second signal now starts at exact offset 10: 
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7.2 Password protection for logicals 

Note, this functionality was implemented in 6.4.2, but it hasn’t been documented in a new 

features document until now. 

In the logicals dialog, there is a Protect button, here you can specify a new or alter an existing 

password.  

 

 

After having saved the analysis, the next time one loads the analysis and tries to access the logicals 
through the logicals dialog, a password dialog will pop up: 

 

 

 

If one can not specify the correct password, access to the logicals dialog will be denied. 

Note that this not prevent one from viewing the logicals in graphs or using the logicals in expressions 
specified in the signal grid, only the expressions used to compose the logicals are protected. Once a 
correct password is specified, the password will not be asked until the analysis is reloaded and one tries 
to access the logicals dialog again. 
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7.3 Path and server replacements for ibaCapture-CAM and HMI 

Note, this functionality was implemented in 6.4.2 but it hasn’t been documented in a new 

features document until now. 

In previous versions of ibaAnalyzer, it was possible to specify a server replacement for 

ibaCapture-CAM in the case the original server had migrated since the recording of the .dat file 

or was only accessible through IP-address. Likewise, it was possible to specify a path 

replacement for ibaCapture-HMI if the .fbr files had moved. This was however limited as only 

one replacement could be specified, which is problematic if the .dat file contained ibaCapture 

modules from several locations or several .dat files were opened. 

In the current version of ibaAnalyzer, the ibaCapture settings dialog (Preferences or Setup) has 

a button labeled “Replace paths” in the HMI section and in the CAM section, it has a button 

labeled “Replace servers”. 

  

 

 

Clicking the buttons causes an additional dialog to pop up: 
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The dialog consists of the following elements: 

 A grid where one can specify the replacements. The following columns are present: 

o Active: Uncheck this column to disable an entry. 

o From: The source string to replace (server in the case of ibaCapture-CAM or a 

full or partial path in the case of ibaCapture-HMI). This is the server or path that 

is expected to be encountered in the opened .dat files. 

o To: The replacement string. This is the server (ibaCapture-CAM) or replacement 

(partial) path (ibaCapture-HMI) to where the actual video data is located. 

o The standard buttons to insert, remove or move entries up or down. 

o A button labeled “Fill from .dat file” that will fill in the “From” entries as 

ibaAnalyzer encounters them in any currently opened .dat files. 

o Ok button to confirm the replacements and return to the setup dialog. 

o Cancel button to discard the changes and return to the setup dialog. 

The order of replacements is important as the first entries will be tried first in the case of multiple 

(partial) matches.  

 


